Word 6 for Windows for Windows Macros for APA Style





The diskette contains one Word 97 for Windows template, APA.DOT and this text, README.DOC.  The template contains Page Layout and Style commands, a macro Shortcut, a macro Toolbar, and the following macros:





					APAINI


					APAREF


					APAFIND


					APANSERT


					APAMARK


					APASELEC


					APANCITE


					APAOOO (O'S not zero's)


					APACH


					APADLETE


					APANOTAT


					APADNOTE


					AUTOOPEN





General Instructions


Check to see that there is no template named APA.DOT in the Templates directory to which you will copy APA.DOT from this disk.  The Templates directory will be:


	C:\Programs\Microsoft Office\Templates\ , C:\Microsoft Office\Templates\, 


	C:\Word 97\ Templates\, C:\Windows\Application Data\Microsoft\Templates,


or something similar.





To call APAREF you need only enter [Ctrl]+; (press the semicolon key while holding down the Control key). Call APAINI, APAMARK, APAFIND, APANCITE, or APACH by clicking the corresponding Button on Toolbar 1.  To call the other macros you must use the Macro dialog on the Tools menu, or you can use Customize on the Tools menu to add your own shortcuts or buttons.





You may cancel safely at any time by pressing [Esc].





You can assume that the macros will do all necessary formatting, underlining, and punctuation unless you are instructed otherwise.





When responding to the prompts, either click the appropriate tab to the appropriate box and press [Enter], e.g. [Tab][Enter] is equivalent to clicking the OK box.  When making selections from a menu, use the mouse or arrows to select the desired choice, or press the first letter of the desired choice.  And finally, if you do not have the information asked for by a prompt, or if you do not wish to include that information in the reference, just click OK and the next prompt in the sequence will appear.  





APAINI


For a brand new paper, click New on the File menu, select the ‘Create New Document’ radio button, and then choose the APA.DOT template.  APAINI should be called the very next thing - it sets up the 'References' in a separate Document Window, and prompts you to enter a page header.





	If you already have a manuscript or partial manuscript that does not use the APA.DOT template , you must Attach the APA.DOT template to it.  Use the Templates and Add-Ins dialog on the Tools menu, making sure that the "Automatically Update Document Styles" box is checked. 	If you already have a reference list, you must place it in a separate Document Window, and make sure that it conforms to the following format: 1) It  must begin with the word "References" centered horizontally (do not use tabs) on the first line.  2) Each reference must be a separate paragraph and begin with a tab.  3) The references must be in alphabetical order.  4) There should be no extra paragraph marks.  5) There should be no annotations.  You can check for annotations by clicking the Show/Hide icon on the Standard Toolbar.  APADNOTE will remove all of the annotations from any document.


	Once the reference list is in a separate Document Window, attach the APA.DOT template to it as above, and call the APANOTAT macro (from the ‘References’ document).  In the case of documents not initiated with APAINI, you must also specify the page header yourself (Use Headers and Footer on the View menu).


�
APAREF


The main macro is APAREF, and is called from the text when citing a source for the first time, and from the references when citing a previously cited source or a preselected source (see below).  It assumes that either APAINI has been called to set up the Document Windows for the text and references, or that they conform to the format set up by APAINI.





With a little practice APAREF should be pretty easy to use, but note the following general remarks:


	1. The insertion point should be at the point in the text where you want to place the citation.  However, citations may be moved 'by hand' if they are in the wrong place.  	


	2. You don't have to put final periods at the end of any information asked for except, if desired, at the end of "additional information".


	3. Do not put parentheses around the 'date'.


	4. You do not have to put parentheses around 'more information about the publication', but if you want brackets (i.e. [ and ]), you must type them yourself.


	5. If additional underlining is necessary, you'll have to put it in 'by hand' when the reference has been completed since Word doesn't allow underlining in dialog boxes.


	6. If there is no 'answer' to a question, just click OK.


	7. You may safely cancel with [Esc] any time - if the reference has already been written, it will not be deleted; you may delete it with APADLETE, or, if you will need it later, you can call APANCITE which will mark it with #_NOT CITED_# (see below).


	8. Don't worry about mistakes--you can correct errors later, when you're in 'editing' mode.  References will be alphabetized according to the ANSI order; the entire first line of the reference is used for alphabetizing.  This should be sufficient for correctly alphabetizing most references, including multiple references to the same author(s).  If not, you will have to move the reference 'by hand'.


	








A first citation to a new reference.





After pressing APAREF at the point in the text at which you want the citation to appear, a menu entitled TYPE? will appear.  It will prompt, Choose one: and offer the following  six selections: Author, Editor, No author-Whole book, No author-Article, Corporate author, or Do it yourself.


	If you choose Author, you will be asked to Type in author's(s') names(s).  Type in the author's(s') name(s) as they will appear in the reference, e.g, Freud, S (you do not have to type in the final period);  Koczkas, S., Holmberg, G., & Wedin, L; etc.  The next prompt will ask you to Type in date.  Type in the date without the parentheses, e.g., 1961; 1982, January; etc.  The parentheses will be added by the macro.


	The next prompt determines whether the reference has an article or chapter title or if the reference is to some other kind of publication, i.e, a whole book.  The prompt asks, Is there an article or chapter title?. If there is, press Y.  You will then be asked to Type it in.  In most cases, only the first word of article and chapter titles should be capitalized.


	At this point a prompt will ask, Is the article (or chapter) in an edited book?.  If it is, press Y.  You will then be asked to Type in editor's(s') name(s).  Type the name(s) in as it (they) will appear in the reference, e.g., J. Strachey.  The macro will add (Ed.) or (Eds.) as needed.


	If the article or chapter is not in an edited book, press N, and the next prompt will ask you to Type in the name of the publication.  This will also be the next prompt if there is no article or chapter title and you answered N to that prompt.  Type in the name of the publication as it will appear in the references (except for the underlining, which the macro will do automatically), capitalizing journal titles, but only the first word of book titles.


	After you have entered the name of the publication, a prompt will appear on the screen asking, Is the publication a Journal, Book, Newspaper, or Other?  Magazine and newsletter articles should be categorized as journal articles since they fit the Journal format. A daily newspaper such as The Washington Post, or a monthly newspaper such as the APA Monitor fits the Newspaper format.


	If you choose Journal, prompts will ask you to Type in volume number, Type in issue number, and Type in page number(s).  


	If you choose Book, prompts will ask you to Type in page number(s), Type in place of publication, and Type in publisher.  If the reference is to a whole book and you do not want page numbers to appear in the reference list, click OK when asked for page numbers.  However, if you want page numbers in the citation, you will have to enter them 'by hand'.  If the book is not edited, you will be asked if there is  More information about publication?  If you answer Y, a prompt will ask you to Type in more information about publication.  Here you may enter volume numbers, translators, etc.  This information will not be underlined, and will be  automatically enclosed in parentheses unless you use brackets (i.e. [ and ]).


 


	If you choose Newspaper, a prompt will ask you to Type in page number(s).


	Finally, choose Other for unusual references such as films, computer programs, court decisions, etc. that don't fit the first three formats.  A prompt will ask you to Type in any additional information.  This prompt appears at the end of every sequence and allows you to enter whatever you need to complete the reference.


	If you choose Editor from the menu, prompts will ask you to Type in editor's(s') name(s) and to Type in date.  You will then be asked, Is there an article or chapter title?.  If you answer Y, a prompt will ask you to Type it in.  After you have typed the title in or if you answer N, a prompt will ask you: Is the publication a Journal, Book, Newspaper, or Other?  Here the sequence of prompts will be the same as for Authors above, except in the case of Book, in which case a prompt will appear asking you to Type in page number(s). 


	If you choose No author - Whole book from the menu, prompts will ask you to Type in the name of publication, and to Type in date.  A third prompt will ask you for Additional information about publication?. If you answer Y, you will be asked to Type it in.  At this point you can enter information such as an edition number.  This information will not be underlined, and will be  automatically enclosed in parentheses unless you use brackets (i.e. [ and ]).  Further prompts will then ask you to Type in place of publication, and Type in publisher.


	If you choose No author - Article from the menu, prompts will ask you to Type in title, Type in date, and Type in name of publication. A fourth prompt will ask Is the publication a Journal, Book, Newspaper, or Other.  The following sequence of prompts will be the same as for Authors above.


	If you choose Corporate author, prompts will ask you to Type in corporate name, and Type in corporate abbreviation, if any.  You will then be asked Is there an article or chapter title?  From this point on the sequence of prompts is the same as for Authors above.


	If you choose Do it yourself), a prompt will ask you to Type in the reference.  Type in the reference exactly how you want it to appear in the reference list, including punctuation.


	After you have finished entering all the information concerning the reference, it will be automatically entered into the reference list in alphabetical order. 	A dialog box will appear with the message: You can edit now.  At this point you can make any necessary changes and correct spelling mistakes, dates, etc.


	If the reference was to a Whole book with no author, after you have edited the reference and clicked OK, you will be asked to Capitalize the title.  The title of the book, capitalized, will appear in the citation.


	If the reference was to an Article with no author,  you will be asked to Capitalize the first two or three words and delete the rest.  The first two or three words of the title, in quotation marks, will appear in the citation.


	At this point the window containing the text will reappear.  A menu entitled WHERE? containing the prompt Choose one: and the following three choices will appear: Enclose in parentheses; Date, only, in parentheses; or Inside existing parentheses.  


	If you want to cite two or more references within the same parentheses, enclose the first in parentheses, and then, at the appropriate place(s), cite the following references inside existing parentheses.  You'll have to assure the citations are in proper alphabetical order within the parentheses yourself.








A citation to a reference already in the reference list.





Place the insertion point at the place where you want the citation to appear in the text, and call APAFIND to place the insertion point after the punctuation that terminates 'author(s)' in the reference list.  (You may also do this 'by hand'.)  Next, call APAREF.  If the reference contains #_NOT CITED�_#, it will be treated as a first citation, and #_NOT CITED�_# will be removed. (See APAMARK, APASELEC, and APANCITE below).  If you have not yet called APAREF or APAFIND from the text, the citation will be put on the Clipboard and you will have to Paste it at the place in the text where you want it.





APADLETE


Place the insertion point in the reference that you want deleted, and then call APADLETE and it  will be safely deleted from the reference list.





APAFIND


Call APAFIND from the point in the text where you want the citation.  It will place the insertion point after the puncuation that terminates 'author(s)' in the reference of your choice. APAFIND will prompt you to Type in the first few letters of the reference you're looking for.  You need only type in enough letters to distinguish your chosen reference from any others.  Even if you don't get the exact reference, you will usually be very close and can place the insertion point 'by hand'. 





APAMARK, APASELEC, and APANCITE


If you have 'References' that have been created by or that agree with APAREF's format, you may select uncited references that are to be cited later as follows:


	1. Mark the desired references by placing the cursor in the body of each reference and calling APAMARK which will place a #[Space] at the front of the reference.  You may remove the #[Space] by placing the cursor in the body of the reference and calling APAMARK again.


	2. When you have marked all the desired references, call APASELEC which will place #_NOT CITED�_# at the end of each marked reference and eliminate all the others.


	3. To cite a preselected reference, first use APAFIND to place the insertion point after the punctuation that terminates 'author(s)' in the reference list. (You may also do this 'by hand'.) Next call APAREF, and respond to the following prompts.


	4. If your original references were annotated, then the selected references will also be correctly annotated.  If not, call APANOTAT.





You may place #_NOT CITED_# at, or remove it from the end of a reference by calling APANCITE.  When a reference is cited for the first time, APAREF removes the #_NOT CITED_#. 





APAOOO


A title with no author such as "A uniform system of citation" will be placed in the a's instead of in the u's in the references.  If this happens, go to the window containing the reference list (after the citation has been written), put the cursor in the body of the reference and call APAOOO which will put _#OUT OF ORDER#_ at the end of the reference. When you are ready to print the references, order the misplaced reference 'by hand' and remove _#OUT OF ORDER#_ by placing the cursor in the body of the reference and calling APAOOO again.





APANSERT


The macro APANSERT is called by APAREF, but must also be used if you wish to independently insert a reference in the reference list. First place the reference that you wish to insert at the end of the references, and then call APANSERT.  





APANOTAT


In order for APANSERT to work, the references must each be annotated, and the number of references must be known.  If you start a paper with APAINI, and use only APAREF, the APA macros will insure that each reference is annotated, and that the count is correct.


If, on the other hand you start with a reference list that was not created by APAREF, you must call APANOTAT as described in APAINI above.





APADNOTE


APADNOTE will remove all of the annotations from any document from which it is called, and reset the reference count to zero.





APACH


APACH lets you choose from a menu of greek characters and statistical formats.  After calling APACH, a menu will appear on the screen.  Select the formula or special character that you want.  Statistical formulas, including alpha level, will appear in the text.  Just fill in the numbers.





AUTOOPEN


This macro is automatically called whenever you open a new or existing document that has APA.DOT as its template.  It resets key document variables that are used to locate the text and references.  If you do anything that changes the number assigned to the text or the references in the list of documents in the Window menu after having used either APAREF or APAFIND, you must call AUTOOPEN from the windows containing the text and the references.  For example if there were only two open windows: 1 REFERENCES.DOC and 2 TEXT.DOC, and you opened a third window called SYMBOLS.DOC, the list would now be: 1 REFERENCES.DOC, 2 SYMBOLS.DOC, and 3 TEXT.DOC.  Because the number assigned to TEXT.DOC has changed from 2 to 3, you must call AUTOOPEN from both TEXT.DOC and REFERENCES.DOC.


 


Below you will find an outline of the prompts with sample responses, and a set of citations and references.  These may be used as a tutorial by choosing a reference, calling APAREF, and following the sequence of responses through the outline.


�
	OUTLINE OF PROMPTS WITH SAMPLE RESPONSES


	(Prompts are in bold) 





[APAREF 	has been called from the text.]


		TYPE  Choose one:


		1. Author(s)


			a. Type in author's(s') name(s)._


				 Freud, S


				 Koczkas, S., Holmberg, G., & Wedin, L


				 Newman, P


				 Palm, E. J


				 Posner, M. I


			b. Type in date_


				 1961


				 1981


				 1982, January


				 1981


				 1993, October 29


			c. Is there an article or chapter title? 


				 yes


				 (1)Type it in._


						The ego and the id


						A pilot study of the effect of the 5_HT uptake 											inhibitor, zimelidine, on phobic anxiety


						[Interview with William Epstein, editor of JEP: Human 							Performance]


						Seeing the mind


					 (a) Is the article in an


							 edited book? 


						yes


						 i) Type in editor's(s') name(s)_


						    J. Strachey


						no


				 no


			d. Type in name of publication._


				 The standard edition of the complete psychological works 					of Sigmund Freud {Since APAREF knows that this is an 							edited book the next question is e.(2)(a), below.}


				 Acta Psychiatrica Scandinavica


				 APA Monitor


				 Associative learning and recognition


				 Science


			e. Is the publication a (1) journal, (2) book, 


			   (3) newspaper, or (4) other?_


				 (1) Journal


					(a) Type in volume number._


							63


					(b) Type in issue number._


							Suppl. 290


					(c) Type in page number(s)._


							328-341





				 (2) Book


					(a) Type in page number(s)._


							3-66


					(b) Type in place of publication._


							London


					(c) Type in publisher._


							Hogarth Press


				 (3) Newspaper


					(a) Type in page number(s)._


						 7, 39


				 (4) Other


			f. Type in any additional information._


				 (Original work published 1923)


				 [Enter]


				 [Enter]


				 Manuscript submitted for publication.


				 [Enter]


		2. Editor(s)


			a. Type in editor's(s') name(s)._


				 Glaser, R., & Bond, L


				 Wilson, J. G., & Fraser, F. C


				 Herbert, C. A


			b. Type in date_


				 1981


				 1977-1978


				 1983


			c. Is there an article or chapter title? 


				yes


				(1) Type it in._


						Testing: Concepts, policy, practice, and research 									[Special issue]


						[Facilitating learning efficiency: Assessment scores]					no


			d. Type in name of publication._


				 American Psychologist


				 Handbook of Teratology


				 [Enter]


			e. Is the publication a (1) journal, (2) book, 


			   (3) newspaper, or (4) other?_


				(1) Journal


					(a) Type in volume number._


							36


					(b) Type in issue number._


							10


					(c) Type in page number(s)._


							[Enter]


				(2) Book


					(a) Additional information about publication? 					


							Yes


						i) Type it in._


							 Vols. 1-4


					(b) Type in place of publication._


							New York


					(c) Type in publisher._


							Plenum Press


			f. Type in any additional information._


				 [Enter]


				 [Enter]


				 Unpublished raw data.


		3. No author - Whole book


			a. Type in name of publication._


				 A uniform system of citation


			b. Type in date


				 1981


			c. Additional information about publication? 


				 yes


					Type it in._


						13th ed.


			d. Type in place of publication._


			   Cambridge, MA


			e. Type in publisher._


				 Harvard Law Review Association


			f. Type in any additional information._


				 [Enter] 


		4. No author - Article


			a. Type in title._


				 Study finds free care used more


			b. Type in date._


				 1982, April


			c. Type in name of publication._


				 APA Monitor


			d. Is the publication a (1) journal, (2) book, 


				 (3) newspaper, or (4) other?_


				(3) Newspaper


					(a) Type in page number(s)._


					 	  14


			e. Type in any additional information._


			   [Enter]


		5. Corporate author


			a. Type in corporate name._


				 National Institute of Mental Health


				 Staff


			b. Type in corporate abbreviation, if any._


				 NIMH


				 [Enter]


			c. Type in date._


				 1982


				 1980, September 1


			d. Is there an article or chapter title? 


				 yes


				(3) Type it in._


				    Professionals face tax rises as IRS targets personal-


							service corporations


					 (a) Is the article in an edited book? 


						no


			e. Type in name of publication._


				 Television and behavior: Ten years of scientific progress 					and implications for the eighties


			   Behavior Today


			f. Is the publication a (1) journal, (2) book, 


				 (3) newspaper, or (4) other?_


				(2) Book


					(a) Additional information about publication? 


					    yes


						i) Type it in._


								DHHS Publication No. ADM 82-1195


							no


					(b) Type in place of publication._


							Washington, DC


					(c) Type in publisher._


							U.S. Government Printing Office


				(3) Newspaper


					(a) Type in page number(s)._


							5


			g. Type in any additional information._


			   [Enter]


			   [Enter]


		6. Do it yourself


			a. Type in reference._


				 Stanley v. Illinois, U.S. Supreme Court, argued October 						9, 1971; decided April 3, 1972


		7. You can edit now.


			a. No author (whole book)


				(3) Capitalize above title. 


			b. No author (article)


				(4) Capitalize the first two or three words and  delete 							the rest.


		8. Enclose in parentheses; Date, only, in parentheses; 					 		 Inside existing parentheses._


			 


[The insertion point has been placed after the punctuation 	terminating author(s) in the reference you wish to cite (by 	calling APAFIND), and APAREF has been called.]


	  TYPE  Choose one:


		1. Corporate author


			a. Type in corporate abbreviation, if any._


				 NIMH


		(go to 7.a. above)


�
						Sample Citations





(Freud, 1923/1961)�


(Koczkas, Holmberg, & Wedin, 1981)


(Newman, 1982)


(Palm, 1981)


(Posner, 1993)


(Glaser & Bond, 1981)


(Wilson & Fraser, 1977�1978)


(Herbert, 1983)


(A Uniform System of Citation, 1981)


("Study Finds," 1982)


(National Institute of Mental Health [NIMH], 1982)


(Staff, 1980)


(Stanley v. Illinois, 1972)�  














Sample References


(With comments in bold)





	A uniform system of citation (13th ed.). (1981). Cambridge, MA: Harvard Law Review Association._#OUT OF ORDER#_ Before printing, this reference must be properly ordered 'by hand' and the '_#OUT OF ORDER#_' removed.


	Freud, S. (1961). The ego and the id. In J. Strachey (Ed. and Trans.), The standard edition of the complete psychological works of Sigmund Freud (Vol. 19, pp. 3-66). London: Hogarth Press. (Original work published 1923) " and Trans." and "Vol 19, " were put in 'by hand'.


	Glaser, R., & Bond, L. (Eds.). (1981). Testing: Concepts, policy, practice, and research [Special issue]. American Psychologist, 36(10).


	Herbert, C. A. (Ed.). (1983). [Facilitating learning efficiency: Assessment scores]. Unpublished raw data.


	Koczkas, S., Holmberg, G., & Wedin, L. (1981). A pilot study of the effect of the 5-HT uptake inhibitor, zimelidine, on phobic anxiety. Acta Psychiatrica Scandinavica, 63(Suppl. 290), 328-341.


	National Institute of Mental Health. (1982). Television and behavior: Ten years of scientific progress and implications for the eighties (DHHS Publication No. ADM 82-1195). Washington, DC: U.S. Government Printing Office.


	Newman, P. (1982, January). [Interview with William Epstein, editor of JEP: Human Perception and Performance]. APA Monitor, pp. 7, 39. Additional underlining done 'by hand'.


	Palm, E. J. (1981). Associative learning and recognition. Manuscript submitted for publication.


	Posner, M. I. (1993, October 29). Seeing the mind. Science, 262, 673-674.


	Staff. (1980, September 1). Professionals face tax rises as IRS targets personal-service corporations. Behavior Today, p. 5.


	Stanley v. Illinois, U.S. Supreme Court, argued October 9, 1971; decided April 3, 1972. Should be underlined when cited.


	Study finds free care used more. (1982, April). APA Monitor, p. 14.


	Wilson, J. G., & Fraser, F. C. (Eds.). (1977-1978). Handbook of teratology (Vols. 1-4). New York: Plenum Press.


�











 





 








�. "1923/" was put in 'by hand'.


�. The underlining and date were put in 'by hand' in the citation.








